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Introduction  

During the last years several European countries have been experiencing an increased influx of refugees, 

mainly children, and a significant amount of effort has been devoted to the integration of those children in 

the host countries’ education systems. Nonetheless, relevant data show that students with a migrant 

background across the European Union have lower educational performance and are more likely to leave 

school earlier than native ones. Provided that refugee children do not commonly speak the host country 

language and most have been out of school for a significant amount of time, specialised knowledge and 

teaching skills are required of teachers so as to provide educational support to this vulnerable population. 

Teachers’ training is essential in order for them to meet the needs of migrant pupils, in particular of those in 

secondary education whose needs are increased, improve their school performance and prevent them from 

dropping out of school.  

HOPEFUL (Extending teacHers' cOmPetences in the effective teaching of numeracy, literacy and digital skills 

to rEFUgee chiLdren) aims to improve the performance of secondary school-aged refugee and/or migrant 

children who have remained outside the educational system for an extended period of time in numeracy, 

literacy and digital competences and to reduce refugee and/or migrant pupils’ early school leaving in Malta, 

Greece, Italy and Cyprus. In specific, the project aspires to enhance secondary school teachers’ aptitude in 

teaching numeracy, literacy and/or digital skills to refugee and/or migrant children with learning gaps due to 

interrupted education and with minimal native and/or English language skills through online training. 

Moreover, a key goal of HOPEFUL is the creation of an innovative diagnostic tool for the effective assessment 

of numeracy, literacy and digital competences, gaps and needs of refugee and/or migrant pupils.  

Since each country has a different education system, the exercises for assessing the aforementioned 

competences are not based on specific age clusters, but on two broader education stages of secondary 

education: Lower Post-Primary (typically covers ages 12 to 15) and Upper Post-Primary (typically covers ages 

15 to 18). The present Booklet involves the diagnostic tool created for secondary school teachers to support 

them in accurately assessing the numeracy, literacy and digital competences, gaps and needs of Lower Post-

Primary pupils with a refugee and/or migrant background. It is expected that the accurate diagnostic 

assessment will allow teachers to identify gaps and misconceptions, differentiate learning needs and make 

informed decisions so as to address the actual needs of the pupils and assist them in bridging the gaps caused 
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by interrupted education, thus, reducing the likelihood of early school leaving. The tool entails three main 

components and provides methods and practices for assessing:  

 Numeracy Competence: Numerical, Algebraic, Graphical, Statistical Skills  

 Literacy Competence: Reading Comprehension, Oral Language, Writing and Composition, 

Arguing/Reasoning, Critical Thinking  

 Digital Competence: ICT Basics, Operation, Word Processing, Internet and Digital Safety 

 

The accompanying Teachers’ Manual designed to supplement the present Booklet provides teachers with 

more information on the procedures to follow during testing, test time allocation, correct answers to the 

exercises, student performance descriptors, guidelines for scoring, evaluation and appropriate use of students’ 

results. 
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About me  

Dear student, 

This Booklet entails a number of exercises on the topics of Numeracy, Literacy and Digital skills. The aim of 

these exercises is to help your teachers understand your prior knowledge on these topics and prepare their 

learning material accordingly so as to better suit your learning needs. Your teachers will you give you 

instructions on how to complete the different exercises. But before you start, let’s learn a little more about 

you! 

 

 

First Name                                                                                           What is your favourite subject? 

-------------------------------------------------------                                   ------------------------------------------------------- 

Last Name                                                                                           What would you like to learn more about? 

-------------------------------------------------------                                    ------------------------------------------------------- 

Age                                                                                                       What do you want to be when you grow up?     

-------------------------------------------------------                                    -------------------------------------------------------    

Country 

------------------------------------------------------- 

Language 

------------------------------------------------------- 

Other Languages 

------------------------------------------------------- 

Have you attended school before? For how long? 

------------------------------------------------------- 
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1. Numeracy Competence 

The first chapter of this booklet features exercises on the following 3 topics of Numeracy Competence: 

1.1. Numbers 
1.1.1. Natural and Integer Numbers 
1.1.2. Operators 
1.1.3. Fractions 
 

1.2. Algebra 
1.2.1. Relationships in Patterns 
1.2.2. Linear Expressions 
1.2.3. Linear Equations   
 

1.3. Statistics and Data Handling 

1.1. Numbers 

1.1.1. Natural and Integer Numbers 1 

1. Which one of the following is a natural number? 

 

a. - 5 

b. 3/7 

c. 2,112 

d. 1.000.000 

 

 

 

 

 
1 https://www.mathway.com/ 

https://www.mathcentre.ac.uk/ 

http://www.math.com/ 

https://www.math-only-math.com/  

https://www.mathway.com/
https://www.mathcentre.ac.uk/
http://www.math.com/
https://www.math-only-math.com/
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2. Is zero a natural number? 

 

a. Yes 

b. No 

c. It depends on the context 

d. Sometimes 

 

3. The number .64 is an example of a ______. 

 

a. whole number 

b. decimal 

c. remainder 

d. division problem 

 

4. Put the following in increasing order: 

 

a. -2, -5, +8, -9, +11 

b. -11, +21, -31, +41, -51 

c.  +4, -10, 0, +6, -9 

d. -6, -2, -8, -15, -22 

e. -16, +19, +34, -47, -88 

f. -10, +6, -50, +10, 0 

 

5 Write: 

 

a. 4 numbers greater than - 5 but less than 0 

b. 5 numbers greater than - 6 but less than 1 
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6. What are the solutions of the following equations? 

 

a. X + 8 = 12   

b. Y - 9 = 25 

c. X + 15 = 6 

d. 3 x Y = 9 

7. Solve the following: 

a. Find two consecutive integers whose sum is equal 129. 

b. The sum of three consecutive even integers is equal to 84. Find the numbers. 

c. The sum of the first and third of three consecutive odd integers is 131 less than three times the 

second integer. Find the three integers. 

8. Factor the following numbers to their prime factors. 

 

18     6     14 

/ \    / \    / \  

 

1.1.2. Operators 

1. Solve the following additions and subtractions: 

 

8673 - 1448 =  

 

9759 - 9133 = 3225 - 2649 =  8646 + 9848 = 5574 - 4984 = 

8062 - 1538 = 

 

7030 + 8803 = 8105 + 6802 = 3893 + 4439 = 5336 - 2864 = 

4598 + 3634 =  

 

6987 - 5802 =  5916 + 1806 =  3204 - 2652 =  2897 + 5307 = 
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2. Solve the following multiplications and divisions: 

 

84 / 12 =  

 

27 / 3 = 60 / 10 =  34 / 2 =  108 / 18 = 

160 / 8 = 

 

323 / 19 =  64 / 8 =  6 x 13 = 8 x 18 = 

19 x 18 = 

 

3 x 6 = 14 x 16 = 11 / 11 = 14 x 4 =  

 

 

3. Solve the following algebraic equation. Choose the correct answer: 

(x + 3) / 0 = ______. 

a. Undefined 
b. 0 
c. 1 
d. -3 

 

4. What is one reason that a number cannot be divided by zero? 

 

a. There is no result 

b. None of the answers are correct. 

c. Because it's an odd number. 

d. Because it's an even number. 

 

5. Evaluate each expression using the rules for order of operations. 

 

6 + 7 x 8 
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1.1.3. Fractions  

1. Convert to decimals: 

 

a. 6/10 =     

b. 41/100 =     

c. 76/100  

 

2. Compare the fraction without changing to equivalent fractions:  

 

1/2 ______ 7/9 

 

3. a. Order the fractions from smallest to greatest: 

 

3/7, 3/4, 2/9, 8/11, 7/10 

 

    b. Order the fractions from greatest to smallest 

 

7/9, 2/5, 1/6, 6/8, 5/9  

 

4. Solve the following:  

 

Sally ate 2 candy bars and Sam ate 3/4 of a candy bar. How much did they eat together? 

a. 2, 3/4 

b. 2/1 

c. 5/5 

d. 10/4 
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5. Solve the following: 

 

7+ 12/13   
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1.2. Algebra 

1.2.1. Relationships in Patterns 2 

1. Find the next number in the following sequences: 

a. 3, 6, 18, 72, ...;  

b. 1, 9, 17, 33, 49, 73, ...;  

2. Identify the rule for this numerical sequence: 

 

15, 20, 25, 30, 35, 40, , , 55, , 65, 70, 75, , 85,    

 

3. Solve the following: 

a. Given that x satisfies the equation ∣2x+3∣=∣2x−1∣, find the value of ∣4x−3∣−∣6x∣. 

b. The value of x which satisfies the equation 2x-(4-x)=5-x is:  

1.2.2. Linear Expressions 

1. Simplify the following expressions: 

a. 5(x - 4) = 2(x - 3) 

b. -7ab + 6b - 3ab - 4b - 3ab 

c. 4x3 - 2x2 + 5x3 + 2x - 4x2 - 6x 

 
2www.tiger-algebra.com  

 www.cliffsnotes.com  

www.math-exercises.com  

 

 

 

http://www.tiger-algebra.com/
http://www.math-exercises.com/
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1.2.3. Linear Equations   

1. Solve the following linear equations: 

a. 10x - 1 = 16 - 6x    

b. x/2 + x/3 = 5  

c. 3 - y + 5 y/6 = 1/2 - y/8  

d. 9x - 8 = 11x - 10 

 

  



 

15 

 

Diagnostic Tool 
Lower Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

1.3. Statistics and Data Handling 

1. Student Ice cream flavours survey 

 

a. How many sectors are in this circle graph? 

b. What percentage of students preferred chocolate ice cream? 

c. What percentage of students preferred butter pecan ice cream? 

d. What percentage of students didn’t prefer a particular flavour? 

e. If a total of 50 people were surveyed, then how many people preferred vanilla ice cream? 
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2. Students in a class voted on their favourite fruit. Each student voted once. The bar graph below 

summarizes the data collected from the class vote.  

 

 

 

a. What is the range of values on the vertical scale? 

b. How many categories are in the graph? 

c. Which fruit had the most votes? 

d. Which fruit has the least votes? 

e. How many students voted for bananas? 

f. How many students voted for grapes? 

g. Which two fruits had the same number of votes? 

h. List the categories of the graph from the least to the greatest. 
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2. Literacy Competence 

Το δεύτερο κεφάλαιο του παρόντος εγχειριδίου περιλαμβάνει ασκήσεις στα ακόλουθα 5 θέματα Γνώσεων 

στον Αναλφαβητισμό: 

2.1. Reading 
2.2. Oral  
2.3. Writing 
2.4. Arguing/Reasoning 
2.5. Critical Thinking 

 

2.1. Reading 

1. Text Α: The Importance of Breakfast in Child Development 3 

 

In research conducted to establish the benefits of breakfast, it was found that the IQ test results of 

children who do not eat breakfast were generally lower compared to those who ate a well-balanced 

meal for breakfast.  

Another good reason to ensure that children should eat a balanced breakfast is that 4 out 5 children 

do not get enough vitamins and minerals from their lunch and dinner meals. By adding breakfast, 

children are more likely to get the vitamins and minerals they need. Also, children who do not eat a 

good breakfast tend to eat more snacks that are rich in calories, fats and sugar.  

Breakfast improves school performance and nutrition  

Breakfast helps enhance mental performance and concentration during morning activities. Children 

who skip breakfast have slower reflexes, are less attentive and active in the morning. Educators 

 
3 https://logodiatrofis.gr/simasia-prwinou-paidiki-anaptuksi/ 

 

https://logodiatrofis.gr/simasia-prwinou-paidiki-anaptuksi/
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observe that children who come to school hungry have learning difficulties as compared to those 

who eat well. Studies show that children who eat breakfast perform much better in school and have 

extra energy in sports and other physical activities. In addition to ensuring optimal development, it 

also has positive effects on alertness, attention, performance, and on other skills important for school 

success for those who eat breakfast on a daily basis.  

What should the children's breakfast include? 

 Carbohydrates & fiber: whole grains, whole wheat bread, fruit. Also, these specific 

foods are rich in potassium, vitamin C, B vitamins, thiamine, riboflavin and niacin, 

which provide energy. 

 Protein: Together with an amount of carbohydrates in breakfast, it is good to consume 

protein as well so as to keep you full. Protein-rich foods that could be eaten for 

breakfast are: semi-fat dairy products, eggs, unsalted nuts.  

 Calcium: Calcium helps build bones and maintain bone strength. You should get about 

1,000 mg of calcium a day. Excellent choices rich in calcium include yogurt, milk and 

cheese. In addition, it is important for children to combine calcium-rich foods with 

those that are high in vitamin D, which increases calcium absorption. 

A good choice that is simultaneously one of the children’s favourite flavours is milk with whole grain 

cereals. This specific combination offers a triple benefit to the child's body because it: 

 Provides vitamin D and calcium at the same time, resulting in further enhancement of bone 

and tooth health, due to the simultaneous intake of these specific nutrients. 

 Dairy fat increases the absorption of vitamin D, since this substance is fat-soluble. 

 Whole grains enriched with vitamin D are also rich in B vitamins, doubling the body's 

defences. 
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And do not forget: you set the example 

Children imitate adults’ behaviour, so if they do not see their parents eating breakfast, they are likely to resist 

it themselves. Children are not only more likely to start eating breakfast if they see their parents doing it every 

morning, they are also more likely to develop healthier eating habits overall. Parents can encourage their 

children to eat breakfast and plan the weekly menu of the week, food should be immediately available by 

storing it in accessible places in the kitchen (low cupboards), so that children have direct access. 
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1. After reading the text, circle whether the following sentences are True (F) or False (F). 

a. Eating breakfast makes children hungry at school.     T       F 

b. Healthy eating is related to school performance.   T       F 

c. Most children do not get nutrients from the meals they eat.   T       F 

d. Carbohydrates are high in vitamin D.   T       F 

e. Children should not have direct access to food cupboards so as not to choose unhealthy snacks.   T    F 

2. Find and write a sentence of the text that has the following meaning: 

a. Adults are children’s nutrition models. ----------------------------------------------------------------------------------

-------------------------------------------------------------------------- 

b. Eating breakfast leads to better school performance. ---------------------------------------------------------------

----------------------------------------------------------------------------- 

c. Not eating breakfast reduces children's attention and energy in the morning. -------------------------------

--------------------------------------------------------------------------------- 

3. What is the purpose of the text? More than one correct answers. 

a. To highlight children’s bad eating habits. 

b. To provide ideas for a healthy breakfast. 

c. To emphasize the value of a good breakfast at school performance. 

d. To force parents to take responsibility for their children's nutrition. 

4. Find synonyms for the following words: 

a. Get --------------------------------------------------------- 

b. Improves ------------------------------------------------------- 

c. Observe --------------------------------------------------------- 

d. Provide ------------------------------------------------------- 

e. Increases -------------------------------------------------------  

 



 

21 

 

Diagnostic Tool 
Lower Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

5. Find antonyms for the following words: 

a. Attentive ------------------------------------------------------- 

b. Success -------------------------------------------------------- 

c. Important --------------------------------------------------------- 

d. Together -------------------------------------------------------- 

e. Encourage --------------------------------------------------------- 

6. Fill in the blanks in the sentences below to give the correct meaning. 

a. ----------------------------------------------------------------------------------------------------gives simultaneously 

vitamin D and calcium. 

b. ---------------------------------------------------------------------------------------------------- show that children who 

do not eat breakfast have lower intelligence. 

c. ----------------------------------------------------------------------------------------------------causes a feeling of 

satiety. 

d. Breakfast improves, among other things, the skills of----------------------------------------------------------------

---------------------------------------------------------------------------- 

e. ------------------------------------------------- -------------------------------------------------- leads to the 

consumption of foods with more fat and sugar. 

7. What are two of the main ideas in this article? 

a. --------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------- 

b. --------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------- 
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2. Text Β: Μuseums and the Internet. The Greek Example 4 

Nowadays, the Internet has become an essential tool for study, work and leisure. As a result, many 

organisations use and build websites to promote their products or services. Museums are among these 

organisations. The relationship between new technologies and museums began with the aim of managing 

museum collections and recording exhibits. This relationship, however, evolved and their use was extended 

to multimedia stations and applications for presentations and interpretations in exhibitions, while the advent 

of the Internet allowed the construction of websites and various applications (Economou, 2003, 121). 

The benefits of a website are many and varied. According to Schweibenz's research published in an article 

entitled, "The "Virtual Museum": New Perspectives For Museums to Present Objects and Information Using 

the Internet as a Knowledge Base and Communication System", the benefits of using the Internet are: a) the 

potential of global publicity, b) museum’s communication with the public and its partners, c) virtual 

exhibitions, d) access to the institution’s collections, e) the potential of researchers’ remote access of online 

databases. What has been mentioned so far are not only benefits, but also factors in order to create a website. 

But to what extent is this practice followed in Greece?  

During the implementation of the Museum Tracker website on our website, the Internet search of Greek 

museums was frequent. […] Based on this search, we reached the following conclusions: a) a great lack of 

museum websites in the countryside, b) careless design of several websites, c) Attica and Thessaloniki 

museums use the Internet more to achieve their goals, something that is evident in the large number of 

websites, d) difficulty in finding photographs for free use, especially in the case of countryside museums, 

without this being the rule. 

The causes of these factors are described as follows: a) financial reasons, b) mismanagement of the 

organization, c) lack of knowledge of Internet use. The latter is quite common in the countryside where 

computer use is lower and digital illiteracy is higher. Regarding the second and the first factors, we can see a 

connection between them. The mismanagement of an institution can be related to the lack of knowledge or 

love for the museum by the people who constitute it or a complete lack of personnel due to financial problems. 

In the museums of the countryside, it is not uncommon to meet people from the area, e.g. neighbours, to 

 
4 https://www.mouseiologia-museology.gr/l/moyseia-kai-diadiktyo-to-elliniko-paradeigma/ 

 

https://www.mouseiologia-museology.gr/l/moyseia-kai-diadiktyo-to-elliniko-paradeigma/
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open and close the museum due to lack of personnel. However, financial difficulties are not only related to 

personnel, but also to the inability to create and maintain a website. What can be done in this case? 

Having a website for every museum is essential. In a world where technology is growing rapidly and is 

becoming almost essential to man for daily life, work, education, entertainment, it is unthinkable not to have 

access to a museum via the Internet. When there is a will, solutions to this issue are simple. Creating a website 

can be very simple and almost cost-effective, using various sites that specialize in it, such as Webnode, 

Simplesite, Google and others. The management of a website can now be done quite easily, as long as you 

search the area you are at. Either an adult or a teenager (yes, a teenager!) can help manage the website by 

taking it on or teaching someone else - it could be the museum manager – how to use it. Therefore, nothing 

is difficult as long as there is a will! As for the availability of more photos for free use, it is up to the choice of 

each institution and whether it wants its doors to be "open" to the public. May we see more good practices in 

the future! 

 

References: 
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1. After reading the text, circle whether the following sentences are True (F) or False (F). 

a. The Internet is practically used by very few people to promote their products and services.  T     F 

b. Creating a website is essential for every museum.  T       F 

c. One of the difficulties in creating a website is the increased cost.   T       F 

d. The free circulation of photos is a problem that is especially evident in the countryside.  T       F 

e. Financial reasons and the lack of knowledge of Internet use are interdependent factors in the 

inability to create a website.  T       F 

2. Find and write a sentence of the text that has the following meaning:  

a. They are advantages and conditions of creating a website. --------------------------------------------------------

----------------------------------------------------------------------------- 

b. The economic factor is related to the lack of staff and the cost of the website. ------------------------------

-------------------------------------------------------------------------------- 

c. Managing a website does not entail particular difficulties. ---------------------------------------------------------

-------------------------------------------------------------------------- 

3. According to the article, what are the benefits of using the Internet for museums? Describe them in your 

own words. 

--------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------------- 

 

4. Find synonyms for the following words  

a. Nowadays --------------------------------------------------------- 

b. Allowed ------------------------------------------------------- 

c. Partners --------------------------------------------------------- 

d. Difficulties ------------------------------------------------------- 
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e. Essential ------------------------------------------------------- 

5. Find antonyms for the following words: 

a. Potential ------------------------------------------------------- 

b. Frequent ------------------------------------------------------- 

c. Connection ------------------------------------------------------- 

d. Lack ------------------------------------------------------- 

e. Help --------------------------------------------------------- 

6. What are the main conclusions of the authors about the Greek museums’ presence on the Internet?  

a. Museums in the countryside have a smaller Internet presence. 

b. Most museums are carelessly designed. 

c. Finding free photos for museum websites is not easy. 

d. All of the above 

e. a and c 

f. a and b 

g. b and c 

7. The text describes the causes of the museums’ decreased online presence and proposes solutions to 

address them. Connect each cause to its solution, describing them in your own words. 

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------- 
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8. Which of the problems you described above do you find most difficult to solve? Justify your choice briefly. 

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------- 

  



 

27 

 

Diagnostic Tool 
Lower Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

3. Text C: Eating Disorders in Adolescence May be Related to Childhood Eating Habits 5 

Source: https://neurosciencenews.com/teen-eating-disorders-picky-eaters-14698/ 

 

According to new research, children who are picky eaters are at an increased risk of developing anorexia 

during their teen years. Those who overeat as children are at higher risk of binge eating disorders. Persistent 

undereating during childhood increased the risk of developing anorexia in teen years by 6% for girls. 

Overeating, undereating and ‘fussiness’ in early childhood can be linked to anorexia and binge-eating in 

adolescence, and the risk is greater for girls, according to a new study from the UCL Institute of Child Health. 

[…]. The researchers analyzed data from 4,760 participants from Avon Longitudinal Study of Parents and 

Children (Children of the 90s), a population-based longitudinal cohort of parents and their children born in the 

South West of England in 1991 and 1992. Information from parents reporting on their children’s eating habits 

was collected at eight points during the ages of one and nine and then linked with eating disorder outcomes 

at age 16. 

The results show that children with increasing levels of overeating throughout childhood have a 6 percentage 

point increased risk (from 10 to 16%) of engaging in binge eating compared to children with low overeating. 

First author, Dr. Moritz Herle said: “From a large robust cohort we were able to identify patterns of eating 

behaviors at an early age that may be potential markers of later eating disorders. Our results suggest that 

children who show high and persistent levels of fussy eating might be at increased risk of developing anorexia 

nervosa, and children who overeat persistently are at a higher risk of binge-eating in their teenage years.” The 

team also found that persistent undereating during childhood was associated with a 6 percentage point 

increased risk (from 2 to 8%) of anorexia in adolescents, but only in girls. Children who were fussy eaters 

throughout childhood had a 2 percentage point risk increase for anorexia (from 1 to 3%), compared to children 

who were not fussy eaters. 

Lead author Dr. Nadia Micali (UCL Great Ormond Street Institute of Child Health) added: “Our study helps us 

to understand who might be at risk of eating disorders and extends what we know from previous studies and 

from clinical observations. Eating disorders are highly complex and influenced by interactions of biological, 

 
5https://neaygeia.gr/2019/11/oi-diatrofikes-diatarache-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-

paidiki-ilikia/ 

 

https://neurosciencenews.com/teen-eating-disorders-picky-eaters-14698/
https://neaygeia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
https://neaygeia.gr/2019/11/oi-diatrofikes-diataraches-stin-efiveia-syndeontai-me-tis-diatrofikes-synitheies-stin-paidiki-ilikia/
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behavioral, and environmental factors and this study helps to identify some of the behavioral mechanisms 

behind these associations.” Dr. Agnes Ayton, chair of the eating disorders faculty at the Royal College of 

Psychiatrists, said: “This study shows that early identification and targeted intervention for disordered 

childhood eating may reduce the future risk of eating disorders. However more research is needed to 

disentangle the biological, behavioral and environmental risk factors, in order to improve health outcomes for 

children and teenagers.” 

 

Article: Herle, M., Stavola, B., Hübel, C., Abdulkadir, M., Ferreira, D., Loos, R., Bryant-Waugh, R., Bulik, 

C. M., & Micali, N. (2020). longitudinal study of eating behaviours in childhood and later eating 

disorder behaviours and diagnoses. The British Journal of Psychiatry, 216(2),113–119. 

doi:10.1192/bjp.2019.174 
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1. After reading the text, circle whether the following sentences are True (F) or False (F).  

a. Reduced food intake in childhood also increases the risk of developing anorexia in adolescence by 

9% for girls. T       F 

b. Eating disorders are mainly due to biological factors. T       F 

c. Children who overeat are at risk of binge-eating during adolescence. T       F 

d. Children who are fussy eaters are at greater risk of anorexia. T       F 

e. The risk of overeating in adolescence is higher for girls. T       F 

2. Find and write a sentence of the text that has the following meaning:  

a. Eating patterns in childhood determine potential eating disorders in the future. ----------------------------

--------------------------------------------------------------------------------- 

b. Picky eating in childhood may be associated with anorexia in adolescence. -----------------------------------

------------------------------------------------------------------------------ 

c. Eating disorders occur from the simultaneous presence of several factors. -----------------------------------

-------------------------------------------------------------------------------- 

3. What is the main finding of the research mentioned in the text? 

a. Poor eating habits in childhood inevitably lead to eating disorders in adolescence. 

b. Boys are less at risk of developing eating disorders in adolescence. 

c. Eating disorders are particularly common in adolescence. 

d. All of the above. 

e. None of the above 

4. Find synonyms for the following words: 

a. Developing -------------------------------------------------------- 

b. Linked -------------------------------------------------------- 

c. Suggest -------------------------------------------------------- 

d. Found -------------------------------------------------------- 

e. Know -------------------------------------------------------- 
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5. Find antonyms for the following words: 

a. Persistent -------------------------------------------------------- 

b. Risk -------------------------------------------------------- 

c. Extends -------------------------------------------------------- 

d. Complex -------------------------------------------------------- 

e. Improve -------------------------------------------------------- 

6. Fill in the blanks in the sentences below to give the correct meaning. 

a. ---------------------------------------------------------------------------------------------------- can clarify what are the 

biological, behavioral and environmental risk factors for the occurrence of eating disorders. 

b. --------------------------------------------and---------------------------------------------------- may decrease the risk 

of eating disorders in the future.  

c. ------------------------,----------------------------and --------------------------------------- have been associated to 

some extent with anorexia and binge-eating in adolescence.  

 

7. What is the main point of the text? How is this relative to Text A you read previously? Briefly describe the 

common points between the two.  

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------ 
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2.2. Oral 

1. Prepare and present to your classmates the following topic regarding your free time. Do you have a 

favourite creative activity (a game that pleasantly fills your hours, an activity that is related with your 

tradition, a musical instrument you learn) or do you join an environmental or other group of excursions in 

nature? 

 

a. When and how did you start spending your time with it? 

b.  What does it offer you?  

c.  Why do you like it? 

 

2. Separate into teams of 2 persons. You have 20 minutes to discuss in your teams, the events in your 

cultures when there would be festivals. Based on your background and your cultural experience, talk about 

the elements that makes a good party. Please take notes and afterwards you will present it6. 

 

3. In groups of 2, discuss with each other about your everyday life first in your country of origin and then in 

your host country. You have 10 minutes to discuss this topic and then each student has to present the life 

of his/her couple. 

 

4. Take 5 minutes to observe the following painting7 with reply to the following questions: 

 

a. Could you please describe the painting? What impresses you the most? 

b. Why do people love painting animals and nature? 

c. Do you usually go to parks in your free time? 

d. What is your relationship with animals? 

 

 

 
6 https://teachingrefugees.azurewebsites.net/wp-content/uploads/2013/06/Sample-Unit-showing-Best-Practice-Methodology1.pdf 
7 https://www.brooklynmuseum.org/opencollection/objects/610 

https://teachingrefugees.azurewebsites.net/wp-content/uploads/2013/06/Sample-Unit-showing-Best-Practice-Methodology1.pdf
https://www.brooklynmuseum.org/opencollection/objects/610
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2.3. Writing 

1. Write an announcement to the announcement board of the school in order to inform students that next 

week a charity bazar event will take place and they have to bring different kind of products for low-income 

families of the municipality.  

 

2. Write a short article about the winning result of the school football team in the final of the regional school 

championship. Use the following words: team spirit, competition, last minute, success, triumph. 

 

3. Give a speech to your classmates in order to convince them to vote you for president in your upcoming 

school class elections. 
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2.4. Arguing/Reasoning 

1. Prepare with your classmate the arguments for the following dialogue. Separate the roles with your 

classmate. 

 

Student A 

You are a person that has not joined any social media platform. Your friend always spends a lot of time 

in social media accounts such as facebook, Instagram and tiktok. She tries to convince you to create 

accounts in all these platforms saying that this will help you to foster your social skills. You refuse to 

do so and you explain the reasons that you do not want to create accounts on social media. 

 

Student B 

Your friend is a person that is not a member of social media and he does not have an account on 

facebook. You are spending plenty of hours on social media contacting friends and people all around 

the world. You try to convince your friend to join social media, so as to improve his sociability. 

 

2. Prepare with your classmate the arguments for the following dialogue. Separate the roles with your 

classmate. 

 

You are watching a movie in the cinema. The mobile phone of the person sitting next to you is ringing 

constantly and he speaks on the telephone for a long time. You are kindly asking him to hang up the 

phone. He continues to speak without caring about your annoyance. You get angry and you explain 

why he needs to hang up the phone. 

 

3. Prepare an argumentation text with the following topic: Encourage your peers to spend their free time 

creatively instead of browsing the internet for hours. 
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2.5. Critical Thinking 

1. Comment on Charles Swindoll’s phrase “Prejudice is a learned trait. You are not born prejudiced; you are 

taught it” in a paragraph of 70-90 words. 
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3. Digital Competence 

The third and final chapter of this booklet features exercises on the following 4 topics of Digital Competence: 

3.1. ICT Basics 

3.2. Operation 

3.3. Word Processing 

3.4. Internet and Digital Safety 

3.1. ICT Basics 

What is a computer? 

A computer is a machine that, through programming, can be ordered to carry out sequences of arithmetic 

or logical operations automatically. Modern computers can execute programs, which are generalized 

collections of operations. Computers can now perform a wide variety of tasks thanks to these programs. 
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Basic functions of the computer 

The basic functions of the computer, such as they are shown in the diagram of Figure 1, are the following: 

 

▪ Data input (the data is "Raw" information) 

▪ Data processing (based on instructions included in program) 

▪ Save information (for editing later) 

▪ Function output 

 

 

 

 

 

Data and information 

They are kindred concepts related to processing. In general, with the term data we mean the elements that 

need to be entered in order for the processing to take place, while by information we mean the results 

obtained from data processing. 
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Processing 

In general, processing is the process of converting data into information, meaning that the data is 

transformed in such way that results in the creation of additional knowledge. A key difference of the 

computer compares to other human created machines, is the ability to choose what kind of processing is to 

be done each time. We achieve this by choosing from a collection of different programs which one the 

computer will follow each time. 

 

Where Are computers used 

In almost all human activities, processing is needed along with the storage of information. Therefore, the 

computer (which is the main tool that people use for these purposes) finds more and more applications. In 

our home we use the computer to find information from the Internet, to communicate with friends, listen 

to music, watch movies, play games, but also to process documents (text), photos, etc. The computer is 

primarily a means of communication and entertainment. 
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Informatics 

Informatics is the science that deals with the collection, storage, processing and transmission of information. 

Because the computer is the machine that collects, stores, processes and transmits information, Informatics 

is very closely related to the computer. Science, however, is not limited only to matters relating to 

computers, but it explores all ways of collection, storage, processing and transmission of information, 

through which the machines can emerge and replace the current computer. 
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EXERCISES:  

 

1. Discuss in groups where the computers can be used and what can we gain from that. 

 

 

2.  Write in the rectangular shapes below the basic functions of the computer: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now write in the bubbles above, two components/units that you have/see in your laboratory where they 

are used to perform these basic functions: 

 

(Note: ATTENTION!!! There is only one component/unit per bubble.) 
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3.2. Operation   

Introduction   

As we have already learned, a computing system consists of the hardware of the computer (devices and 

components) along with the software (the programs by which the user determines what processing the 

computer will do). But in order for the user to choose which program he wants to activate, there must be a 

mechanism, which after receiving his command, can locate and activate the specific program. In order for this 

to apply, there should be a specialized program whose job is to accept commands from the user and activate 

other programs. This specialized program is called the operating system. 

1. The operating system and its role 

The operating system is a software that is necessarily present in every computer because it coordinates its 

operation and provides the user with the following basic services: 

 The ability to interact with the computer, providing a communication environment, 

 The ability to control programs (on and off) and an archiving system, allowing the user to 

organize and store files. 

 To provide these services, the operating system must control and coordinate all devices 

(hardware) and programs (software) that are present on the computer, so that they operate 

in harmony. 

 

2. Γιατί υπάρχουν πολλά διαφορετικά λειτουργικά συστήματα? 

Ένα λειτουργικό σύστημα δεν είναι κατάλληλο για όλα τα είδη υπολογιστών. Οι προσωπικοί υπολογιστές 

χρειάζονται συνήθως ευέλικτα λειτουργικά συστήματα που υποστηρίζουν πολλά είδη περιφερειακών και 

είναι εύχρηστα. Στους μεγάλους υπολογιστές, η αξιοπιστία του λειτουργικού συστήματος είναι πολύ 

σημαντική, ενώ στις μικρές κινητές συσκευές, όπως τα κινητά τηλέφωνα, υπερισχύουν εξειδικευμένα 

λειτουργικά συστήματα που αντιστοιχούν στις περιορισμένες δυνατότητες αυτών των συσκευών. 
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The list of application software that exists is endless, as new ones are constantly being created, to meet new 

user needs and also deal with already known needs or problems. 

The application software can be purchased from computer stores or downloaded from the Internet (after 

paying). There is also software offered free of charge by its creator (Open Office, Gimp). We should be careful 

because there is pirated software. This is software that we normally have to buy, but someone copied it and 

pronounces it either for free or very cheaply. In addition to being illegal, it could be dangerous to our 

computer. It should be mentioned that there are also specialized programs that use specific organizations, etc. 

the program that creates the school timetable, a warehouse program of a store, which belong to the category 

of Application Software. 
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EXERCISES:  

 

1. What are the three main services that the operating system provides to the user? 

a. write and save text 

b. organize files in folders (filing system) 

c. control the activation/deactivation of programmes 

d. listen to music and watch videos  

e. search for information on the Internet 

f. Interact with the computer through a communication environment. 

2. Why are there so many different operating systems if they all perform basically the same functions? Write 

and justify your views for discussion in the lab 

3. If you were buying a new personal computer, what factors related to its operating system would you 

consider and why? 
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3.3. Word Processing 

Entering text using a keyboard 

To enter text in the text editor, we go to the point we want using the motion arrows or mouse and Type our 

text. 

 

Insert symbols or special characters such as: ©, ®, ™ 

To enter symbols or other special characters we use the following steps: 

 We select the Insert tab. 

 From the symbol group we press Symbol and select the symbol we want. If in the list of 

symbols that appear there is not what we want, click More Symbols for more options 

 

Show and hide non-printable characters  

Non-printable characters are blank spaces, paragraph changes, manual line changes, manual page changes, 

etc. To display or conceal them: 

 We select the Home tab. 

 From the Paragraph group we Press the Show/Hide button . 

 

Edit text in a document by adding or deleting new characters and words 

 To add new characters or words to our text, we move at the point of the document we want 

using the motion arrows or the mouse and we Type our text. 

 to delete characters or words from our text, we move to the point of the document we want 

using the motion arrows or mouse and we use one of the following techniques: 

 We place the cursor to the right of the word and press the keys: Ctrl + Backspace 

 We select the word and press the Del key 

 We place the cursor to the left of the word and press the keys: Ctrl + Delete 

 We move the cursor to the left of the word and press the key Delete continuously until the text 

we want is deleted. 
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Copy text to the same document or between open documents 

We can copy part of a text as follows: 

 We select the part of the text that we want to copy. 

 We can right click and select Copy from the popping window, OR 

 From the Home tab and the Clipboard group, we select the Copy (or we use the key combination 

Ctrl + C). 

Then: 

 Move the cursor to the point of the document that we want the text. 

 We can right click and select Paste from the popping window, OR 

 From the Home tab and the Clipboard group, we select the Paste command (or we use the key 

combination Ctrl + V). 

 

Move text to the same document or between open documents 

We can move part of a text as follows: 

 We select the part of the text that we want to move. 

 We can right click and select Cut from the popping window, OR 

 From the Home tab and the Clipboard group, we select the command Cut (or we use the key 

combination Ctrl + X). 

Then: 

 Move the cursor to the point of the document that we want the text. 

 We can right click and select Paste from the popping window, OR 

 From the Home tab and the Clipboard group, we select the Paste command (or we use the key 

combination Ctrl + V). 

 

Undo and redo orders 

 If when editing a text we make a mistake, with the command undo we can undo the last action 

by pressing key combination Ctrl + Z. 

 To cancel the undo, we can press the key combination Ctrl + Y. 
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EXERCISES: 

 Turn on the text editor. 

 Type the text below: 

Create a document in the text editor 

 Now save the file using the Save command, specifying the following: 

 As the save location, your personal folder on the storage drive 

 As your personal storage device, your personal file on your personal hard drive, as specified by your 

teacher. As the file name, the name Document1. 

 Next, press ENTER to change the paragraph and type the following text: 

Saving a document in the text editor 

 Save the file in your folder again, but with the change you made in the following two ways: 

 Selecting the Save command. What do you notice? 

 Selecting the Save As command. What do you notice? 

 Save the file again in your folder with the name Document2 

 Next, press ENTER to change the paragraph and type the following text: 

Create different types of files 

 Resave the file in your folder, but with the change you made by specifying the following: 

 File name: Document3 

 File type: PDF (*.pdf) 

 Which save command did you use Save or Save As? ........................... 

 Now close the file, but do not close the text editor. 

 Select the New command from the File tab and explore the available templates available. Write 

some of them below: 

 Create a new file using the Welcome to Word template and save it in your folder under the name 

Document4. 
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 Select the Options command from the File tab. 

 Enter your full name as the application's User name. 

 Save the changes you made to your file and close it. 
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3.4. Internet and Digital Safety 

1. What is a computer network? 

Computer network is a group of two or more computers connected to each other in order to exchange data 

or share common regional devices and software (such as printers, scanners, files and programs). 

 

 

 

 

 

 

 

 

 

 

 

 

2. Advantages and disadvantages of networks 

2.1 Advantages: 

 Sharing of digital resources of the system: users, depending with the rights given to them, they 

have access to files, folders and programs that may be on other computers. 

 Sharing peripherals: users can use together the same peripheral devices. If at some workplace you 

have ten computers, you don't have to have ten printers. Through the network, each user can 

access a common printer. 

 Sharing an Internet connection to all its computers network: in a network there are many 

computers, it is not necessary for each computer  to have a different internet connection. With a 

single connection, over the network, all computers can be connected to the Internet. 

 Upgraded communication formats: through the network the ability for direct communication with 

messages is given, along with voice and video as well as the ability to communicate using e-mail. 
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2.2 Disadvantages: 

 Financial costs: for the creation of a new network there are additional costs for the purchase 

and installation of the necessary devices; and programs. 

 Complexity: the maintenance and management of a network is complex and usually the 

knowledge of specialists is required. 

 The spread of viruses: through a network, if the necessary protection is not obtained  in terms 

of measures, it becomes very easy to spread viruses. 

 

1. Internet  

The Internet is a broad network comprised of many networks. It is the largest computer network in the 

world. Computers are connected to each other by telephone and other lines. It's a grid of billions 

interconnected computers stretching to almost every corner of the planet and provides its services to 

billions of users. 

 

Services provided by the Internet 

 Global information Web known as World Wide Web (WWW) 

 E-mail (e-mail) 

 Online newsgroups 

 Real-time chat (Facebook, MSN, Skype) 

 E-commerce 

 Distance education and training (e-learning and e-training) 

 

2. Safe use of the Internet  

Go to a website if we know its address (URL) 

If we know the address (URL) of a website,  we can visit it by typing in the "Address" section (address) of the 

window web browser, the specific address 

 

 



 

49 

 

Diagnostic Tool 
Lower Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

 

 

Search Engines 

A search engine is an application that allows searching texts and files on the Internet. Some of the best-

known search engines are: 

 Google -> http://www.google.com/ 

 Yahoo -> http://search.yahoo.com/ 

 Bing -> http://www.bing.com/  

To track down information using a search engine you need to do the following: 

1. In the address bar of the browser, we type the address of a search engine, www.google.gr  and we 

press Enter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In the box we type the keywords related  to our search. 

3. We press the search button. The search results are displayed  as it is shown in the picture above 

http://www.google.com/
http://search.yahoo.com/
http://www.bing.com/
http://www.google.gr/
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4. From the search results we select the one that is closest to what we ask. 

 

Risks arising from the use of the Internet 

Undoubtedly, the internet and the services it includes, offer users several advantages. At the same time, 

however, there are several risks that arise from the use of the internet. We should be sufficiently informed 

to be able to recognize and address these risks. 

The common risks that can arise with the use of the internet are: 

 Malicious programs and Spam 

 Eavesdropping of Personal Data (Phishing) 

 Getting scammed from untrusted sellers 

 Access inappropriate content 

 Misinformation 

 Copyright infringement 

 Internet addiction 

 Cyberbullying 

 Language Falsification 

 Physical Ailments 
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EXERCISES: 

 

Choose the correct answers 

1. They usually come as attachments: 

a. Virus  

b. Personal Data Theft (Phishing) 

c. Spam 

d. Cyberbullying. 

 

2. An anti-virus (Antivirus) program could help us deal with... 

a. Virus  

b. Personal Data Theft (Phishing) 

c. Spam 

d. Cyberbullying. 

 

3. Deception aimed at providing personal information such as ID number, bank account number is 

related to: 

a. Virus  

b. Personal Data Theft (Phishing) 

c. Spam 

d. Cyberbullying. 

 

4. By never giving out personal information via email is one way to deal with the problem with: 

a. Virus  

b. Personal Data Theft (Phishing) 

c. Spam 

d. Cyberbullying. 
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5. The mass mailing of large numbers of messages which usually involve gambling and product or 

service advertisements is related to: 

a. Virus  

b. Personal Data Theft (Phishing) 

c. Spam 

d. Cyberbullying. 

 

6. To deal with the problem of Spam we can: 

a. not accept attachments 

b. set our email filtering service to automatically reject such messages 

c. keep backups 

d. consult the indications of the age rating system called the Pan-European Game Information 

System 
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